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1 Introduction

Ce manuel explique l'installation, la configuration et l'utilisation du module de paiement
OpenCart 0gone.

Avant de commencer l'installation, assurez-vous d'étre en possession de toutes les données
nécessaires suivantes:

® \Vous recevrez votre PSPID et mot de passe aprés avoir signé le contrat et aprés avoir
finalisé I'ouverture d'un compte de démonstration directement par 0gone

®* Module de paiement OpenCart de sellxed.com/shop

* Données d'accés pour votre serveur et votre boutique

Si vous ne disposez pas encore d'un contrat avec 0gone, vous pouvez le faire directement a
travers nous.

Veuillez noter que nos plugins nécessitent l'utilisation de PHP version 5.6 au minimum. PHP 8 ou
supérieur n'est actuellement pas pris en charge.

1.1 Procédure de l'installation

Dans ce document, vous trouverez toutes les informations importantes pour l'installation du
module. Il est important de suivre strictement les étapes suivantes a fin de garantir l'utilisation
en conformité aux réglements de Sécurité.

5/36



sellxed

La configuration de l'interface d'administration de Ogone.
Configuration des parameétres de base du module de paiement
Configuration des modes de paiement

FwbNPe

ce document.
5. Sile testaréussi, copiez toutes les données de votre compte test dans le compte

productif Ogone.

Installation

Par défaut, nos plugins de paiement possédent les paramétres corrects pour la plupart
de nos clients. Cela signifie une fois que vous ayez inséré les informations
d'identification requises dans la configuration du plugin, le plugin devrait étre
entierement opérationnel. Si vous souhaitez recevoir des informations détaillées sur un
parametre que vous ne ConNnaissez pas, vous pouvez contacter notre support.

Si vous avez des problémes pendant l'installation, notre support sera la pour vous. Vous
pouvez nous contacter en cliquant sur le lien suivant: http://www.sellxed.com/support.
Vous avez aussi la possibilité de commander notre service d'installation. Nous
installerons sans problémes le plugin dans votre boutique. http://www.sellxed.com/shop
/de/integration-und-installation.html

Protection de dossier avec votre .htaccess

A fin d'utiliser ce module sans avoir des erreurs, les restrictions d'IP ou de dossiers
doivent étre désactivées. Ceci est nécessaire pour que la notification de paiement de
Ogone puisse atteindre votre boutique.

La réalisation d'un achat test avec les données de test qui peuvent étre trouvées a la fin de
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2 Configuration du back-office Ogone

Pour la configuration, connectez-vous dans le backend Ogone :

® Test:https://secure.ogone.conl ncol/test/backofficel
® production:htt ps://secure. ogone. com ncol / prod/ backoffice/

Les parameétres choisis sur les pages suivantes sont une condition préalable a la configuration
principale du module de paiement.

La configuration des paramétres se fait sous Configuration > Information technique. Dans le
chapitre suivant les titres des chapitre correspondent aux onglets dans le back-office de 0gone.
A certains moments, des captures d'écran seront incluses pour une illustration plus précise. Si
un parameétre dans la documentation n'est pas important pour la configuration du module et
n'est pas visible dans votre compte, il peut étre ignoré.

2.1 Onglet: Paramétres de transactions globaux

Dans cet onglet vous définissez les parameétres de base pour le traitement des transactions.
2.1.1 Code d'opération et Procédure de télécollecte (paiement/data capture) par
défaut

Nous vous recommandons de choisir Vente et "Télécollecte (data capture) automatique par
notre systéme a la fin de la journée.". Tous les payments seront directement capturés et débités.
Sivous utilisez la gestion des transactions et la capture différée, nous vous conseillons d'utiliser
ces parametres. Si vous avez enregistré d'autres parameétres dans le module, ils vont écraser
ceux de la configuration de Ogone.

2.1.2 Tentatives de paiement multiples

Nous recommandons d'insérer 10.

2.1.3 Traitement des transactions individuelles

Nous recommandons I'option "Online mais basculer en offline durant les périodes d’
indisponibilité du systéme acquéreur.".

2.2 Onglet : Paramétres globaux de sécurité

Dans cet onglet vous définissez les parameétres de sécurité pour l'intéraction entre votre
boutique et la passerelle Ogone.
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2.2.1 Méthode de hachage

Les modules de paiement sellxed acceptent tous les modes de hachage de 0gone. Pour que le
module fonctionne, il est important que les parameétres enregistrés dans 0gone correspondent a
ceux enregistrés dans le backend de votre boutique.

Afin de garantir le bon traitement des paiements, nous vous recommandons la méthode de
hashage suivante:

® Chaque parameétre suivi de la clé. Ce paramétre peut ne pas étre visible dans votre
boutique. Dans ce cas, il sera transmis automatiquement.

® Algorithme de hachage = SHA 512

® Encodage des caractéres = UTF-8

Hashing, method

w This configuration affects all signature checks of which the pass phrases are configured under "Data and origin” and "Feedbacks".

i Hash algorithm
SHA-1
SHA-256
* SHA-S12
i Character encoding

Use the character encoding expected with the initial transaction request (depending on the URL called)
IS0-8859-1

® UTF-2

Image 2.1: Configuration de SHA-Hash.

Ces parameétres doivent étre identiques aux parameétres dans la configuration du module
principal). Veuillez noter que I'encodage des caractéres est fixé a UTF-8 dans notre module et ne
peut pas étre modifié.

2.3 Onglet: Page de Paiement

La case sous Cacher le bouton "Annuler" doit étre cochée. Le champ sous Redirection du bouton
"retour" peut étre laissé vide.

2.4 0nglet : Contrdle de données et d'origine

Cet onglet définit les éléments de sécurité concernant la transmission de données et le
chargement de la page de paiement.
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2.4.1 Contr6les pour e-Commerce & Alias Gateway
La premiére case sous "URL de la page du marchand" peuvent rester vide.

La case "CIé SHA-IN" est un élément de sécurité du paiement qui vérifie l'authenticité de la
transaction. Par conséquent, il est important que vous utilisiez la méme clé dans le backend de
votre boutique.

Générer une clé SHA avec I'outil Customweb

Notez que seuls les caractéres ASCIl peuvent étre utilisés pour les clés SHA. Veuillez
utiliser notre outil SHA Customweb afin de n'utiliser que des caractéres valides.

2.4.2 Contrdles pour Ogone DirectLink et Ogone Batch (Automatique)

DirectLink vous permet d'utiliser le mode d'autorisation Hidden (Alias Gateway) ainsi que la
capture directe des transactions depuis votre boutique. Si vous avez activé DirectLink dans votre
compte et souhaitez utiliser cette fonction, insérez la méme clé SHA-IN dans la case "Clé SHA-IN"
comme déja fait ci-dessus.

Plus d'information dans la section Configuration de 'autorisation Hidden.

2.5 O0Onglet: Retour d'information sur la transaction

Dans cet onglet est configurée la réponse de Ogone a la boutique.

2.5.1 Redirection HTTP dans le navigateur

Les paramétres dans la notification de la transaction finalisent la commande dans la boutique
apres le paiement. Les quatre champs sour "Redirection HTTP dans le navigateur" peuvent rester
vides car ils seront configurés dans les paramétres de notre module.

2.5.2 Requéte directe HTTP serveur-a-serveur
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* ['option "Type de requéte" doit etre parametrée sur En ligne mais différer la requéte
lorsque les requétes en ligne échouent.. Sous "Méthode de la requéte" vous devez
sélectionner "POST".

® Dansla section Géneral assurez-vous que l'option "Je veux que 0gone affiche un message
d'attente de traitement au client pendant le traitement du paiement." ne soit pas
sélectionnée.

URL de la page post-paiement du marchand.

Pour le retour de la transaction veuillez insérer I'URL qui sera g¢énéré dans le module principal.
Plus d'information dans la section Feedback de Transaction

Toutes les commandes ont le statut 'pending’

Si vous remarquez pendant les tests que les commandes ne sont pas enrégistrées dans
la boutique et qu'aucun email de confirmation est envoyé, il se peut qu'il y ait une erreur
dans la configuration. Assurez-vous que votre firewall ne bloque aucune requéte envoyée
par Ogone.

Direct HTTP server-to-server request
i Timing of the request
Mo request.
Always deferred (not immediately after the payment).
Always online (immediately after the payment to allow customisation of the response seen by the customer).

# Online but switch to a deferred request when the online requests fail.

m URL of the merchant's post-payment page

If the payment's status is "accepted”, "on hold" or "uncertain”.

SEE MANUAL FOR THIS URL // URL GEMASS MANUAL

If the payment's status is "cancelled by the client" or "too many rejections by the acquirer”.

SEE MANUAL FOR THIS URL // URL GEMASS MANUAL|

Request method
& POST

GET

Image 2.1: Configuration de I'URL de notification pour le HTTP-Feedback.
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Demandes différées et Time Out

0gone envoie les demandes de notification avec un délai d'attente de 20 sec. Si votre
boutique ne peut pas répondre a la requéte HTTP dans ce délai, un message d'erreur de
time out sera affiché. Si vous choisissez I'option En ligne mais différer la requéte lorsque
les requétes en ligne échouent, le retour de la transaction réitéré a 4 reprises avec dix
minutes d'intervalle.

A noter qu'en fonction de votre abonnement 0gone il est possible que la seule option
disponible soit Toujours en ligne (juste aprés le paiement pour prendre le résultat en
compte et personnaliser la réponse au client). Dans ce cas |a, sélectionnez cette option.

2.53 Paramétres dynamiques du commerce en ligne

Avec cette option, vous contrdlez les parameétres qui seront envoyés dans la notification de
Ogone. Pour que les paiements soient transmis a votre boutique, tous les parameétres
nécessaires doivent étre envoyés. Il est possible que vous ayez d'autres options disponibles a
sélectionner. Assurez-vous de déplacer tous les paramétres de Disponible a Sélectionné a part
les parameétres suivants:

®* CN

* SUBBRAND
® AAVADDRESS
® AAVCHECK
* AAVMAIL

* AAVNAME

* AAVPHONE
® AAVZIP

lows y0u ta select or deselect the prameters you wish to receive s feedback for 3 transaction and move them from cne hox to another. Please note that NCERROR, PAYID, ORDERID, STATUS are default parameters and selected s such and eannot be removed.

ACCEPTANCE
AAAAA

Image 2.1: Paramétres dynamiques du commerce en ligne. Votre sélection peut étre différente
en fonction de votre abonnement 0gone.
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2.5.4 Sécurité pour les paramétres de la requéte

La clé "SHA-OUT" est un mécanisme de sécurité supplémentaire pour les paiements. Ici aussi, il
faudra que le mot de passe inséré soit identique a celui configuré dans le backend de la
boutique. Assurez-vous que votre clé SHA-OUT soit différente de la clé SHA-IN.

Générer une clé SHA avec I'outil Customweb

Notez que seuls les caractéres ASCIl peuvent étre utilisés pour les clés SHA. Veuillez
utiliser notre outil SHA Customweb afin de n'utiliser que des caractéres valides.

2.5.5 Requéte http pour les changements de statut

Vous avez la possibilité d'étre informé sur les changements de statut directement par 0gone.
Cette fonctionnalité est particuliéerement utile quand un paiement a un statut incertain car
'acquéreur n'a pas pu étre atteint. Le statut de paiement sera mis a jour automatiquement. De
plus, cette fonction vous permettra de capturer des paiements via 0gone et de synchroniser les
statuts des commandes dans votre boutique.

Pour utiliser cette fonctionnalité, vous devrez sélectionner I'option Lors de tous les changements
de statut offline (paiement, annulation...). Ensuite il suffit de copier I'URL affichée dans l'onglet
setup de la configuration du module (notification des transactions). Insérez I'URL indiquée dans
le champ "URL sur lequel le marchand souhaite recevoir une requéte HTTP différée en cas de
changement de statut de transaction offline (hors ligne)."

HTTP request for status changes
i Timing of the request
Mo request.
Omly at the time of the order authorisation request.
# For each offline status change (payment, cancellation, etc.).

URL on which the merchant wishes to receive a deferred HTTP request, should the status of a transaction change offline.

Image 2.1: Insérer I'URL de la configuration principale du module.

2.5.6 Paramétres dynamiques

Changer tous les paramétres de Disponible a Sélectionné.
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2.5.7 Modéle

Le modéle dynamique vous permet d'afficher la page de paiement avec le design de votre
boutique. Si le champ pour le modéle dynamique n'est pas visible, veuillez contacter 0gone. Vous
devrez faire activer par 0gone des options supplémentaires dans votre compte.

Pour I'utilisation du modeéle dynamique, veuillez ajouter les parameétres suivants:

Activer le controle JavaScript sur le modéle: 'Non'

Nos modules ne permettent pas "l'utilisation d'un modéle statique". Choisissez '‘Non'

e Autoriser 'utilisation d'un modéle dynamique: ‘Oui'

® Sjvous utilisez le modéle dynamique, insérez I'URL de votre site, par exemple:
https://votre-boutique.com dans la deuxiéme case. La case supérieure doit rester vide.

L'activation du modéle dynamique dans la configuration de la boutique est expliqué ici.

Template

Enable JavaScript check on template

Yes

#* No

Allow usage of static template
Yes
#* No

Trusted static template name

i You may enter several template names, separated by ";" (e.q. templatel.htm; template2.php)

Allow usage of dynamic template
# Yes
Mo

Trusted dynamic template URL

i You may enter several template URL, separated by ";" (e.g. https://www.domain.com/tmp/templatel.htm; https://www.domain.com/template2.php)

Trusted website hostname hosting the dynamic template
*

hﬁps:.n’.n‘yourh hop.com

i You may enter several website hostnames, separated by ";" (e.q. https://www.domain.com; https://www.otherdomain.com)

Image 2.1: Configuration du modéle dynamique.

Modéle dynamique

Veuillez noter que vous avez absolument besoin d'un certificat SSL pour l'utilisation du
modeéle dynamique. Sans SSL, les fichiers CSS ne seront pas chargés correctement sur
certains navigateurs.

2.6 Autorisation Hidden, autorisation Ajax (FlexCheckout -
Hosted Tokenization Page), External Checkout & Alias Manager
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Pour l'utilisation de l'autorisation Hidden, l'autorisation Ajax (FlexCheckout), Alias Manager ou
External Checkout pour vos paiements, certaines options seront nécessaires dans le backend de
Ogone. Veuillez au-préalable vérifier que les options suivantes sont activées dans votre compte

sous Abonnement > Vos Options.

Other apy
Available options  [JEEISERY
™ Option
AFTP AFTP Module
D3 D3D (Direct Link 3D)
ELVDE ELV (Direct Debis Germany)
FaCQ Forelgn acquirers
v
—rn e e
opc One Page Checkout
RECOI Recanciliation Module
RECX Alias Manager
scH Scheduled Payments
suB Subscription manager
UsRa User Manager up to 20 users
UsRs User Manager up t0 50 users
UsRe User Manager up 10 100 users
usr? User
(1) CAPI: Includes i

Activation

0CHF

0CHF

0CHF

0 CHF

0 CHF

0cHF

0EUR

0CHF

0CHF

0CHF

0CHF

0CHF

0CHF

0CHF

0 CHF

0CHF

0CHF

0 CHF

0CHF

0CHF

0cHF

0EUR

0CHF

0CHF

0CHF

0CHF

0CHF

0 CHF

0CHF

0CHF

Monthly fee

0CHF

0CHF

0CHF

0CHF

0CHF

0cHF

O0EUR

0CHF

0CHF

0CHF

0CHF

0CHF

0CHF

0CHF

0CHF

Transaction/Unit cast

ccccc

ccccc

ccccc

Image 2.1: Assurez-vous d'activer les options OPC et DPR..

Sil'option n'est pas visible veuillez contacter 0gone.

Options et leur signification :

® pour l'utilisation du mode d'autorisation Hidden, il vous faudra I'option OnePageCheckout

® pour l'utilisation du mode d'autorisation Ajax (FlexCheckout), il vous faudra les options

* Sivous souhaitez également utiliser I'Alias Manager, vous aurez besoin de I'option. Alias

(OPC).

OonePageCheckout (OPC) et DirectLink (DPR).

Manager (RECX).

Si ces options ne sont pas disponibles dans votre compte, veuillez contacter directement Ogone.
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2.6.2 Configuration d'un utilisateur API

Si vous voulez utiliser les fonctions de la gestion des transactions ou le mode d'autorisation
Hidden Authorization (Alias Gateway) vous aurez besoin de créer un utilisateur APl comme décrit
ci-dessous:

Allez sous Configuration > Utilisateurs et cliquez sur 'Nouvel Utilisateur'. Choisissez un nom pour
le champ Utilisateur/userID et insérez un nom de l'utilisateur et une adresse email. Sélectionnez
Administrateur sans user management comme profil. Il est important que vous sélectionnez
I'option Utilisateur "API". Si vous ne voyez pas cette case, il faudra activer I'option DirectLink chez
ogone.

Mot de passe de l'utilisateur API

Le nom de l'utilisateur et le mot de passe peuvent seulement contenir des lettres et des
chiffres. Les caractéres spéciaux ne seront pas acceptes.

Veuillez noter les données d'accés. Elles doivent étre insérées dans la configuration principale
du module de paiement.

2.6.3 Utilisation du External Checkout

Pour l'utilisation du External Checkout des options supplémentaires sont nécessaires. Les
checkouts externes, comme les modes de paiement MasterPass offrent la possibilité de
transférer automatiquement les adresses de livraison et de facturation.

L'utilisation des checkouts externes a besoin de I'option Direct Link et I'activation du mode de
paiement dans votre compte Ogone.

Pour activer le mode de paiement, vous devez vous assurer que dans le tab Information
Technique > Retour d'information sur la transaction dans les options Direct Link tous les
parametres soient sélectionnés.
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Directlink

Dynamic parameters

This exchange box allows you to select or deselect the parameters you wish to receive as feedback for a transaction an
such and cannot be removed.

Available Selected
AAVADDRESS
AAVCHECK
AAVMAIL
AAVMNAME
AAVPHONE
AAVZIR

SAVE
Image 2.1: Paramétre dynamiques Direct Link.
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3 Installation du module dans la boutique
OpenCart

3.1 Installation

A ce moment, vous devriez déja étre en possession du module. Si cela ne serait pas le cas, vous
pouvez télécharger les fichiers nécessaires dans votre compte client dans le sellxed shop (Menu
"Mes téléchargements Téléchargements »). Pour télécharger le module dans votre magasin,
suivez les étapes suivantes:

1. Créez le back-up de votre boutique.

2. Extraire le contenu du fichier ZIP que vous avez téléchargé dans votre compte client.

3. Copiez le contenu entier du dossier «fichiers» dans le répertoire principal du serveur de
votre boutique respectivement au dossier dans lequel les plugins sont copiés
normalement. Pour ce faire, utilisez votre programme FTP habituel. Assurez-vous que les
dossiers ne sont pas remplacés, mais simplement fusionnés.

4. Sivous ne l'avez pas encore fait, connectez-vous dans votre boutique.

3.2 Miseajour

Pendant votre période de support, vous pouvez télécharger a tout moment les mises-a-jour du
module. Pour vous abonner aux mises-a-jour veuillez suivre les pas suivants: https://www.
sellxed.com/en/updates_upgrades.

3.2.1 Liste de contréle

N'oubliez pas de suivre les pas suivants avant la mise-a-jour:
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1. Créez un backup avant la mise-a-jour de votre systéme

2. Testez d'abbord la mise-a-jour sur un environnement de test. Nous testons nos modules
dans nos environnements de test, cependant des erreurs peuvent se passer avec d'autres
plugins dans votre boutique.

3. Continuez avec le téléchargement des fichiers sur votre serveur et ouvrez la configuration
principale du module. Sivous utilisez un cache, videz-le.

Quelques mises-a-jour doivent actualiser le schéma de quelques tables la base de donnée. Nous
vous conseillons d'actualiser le module pendant un certain temps ot vous n'avez pas beaucoup
de trafic sur le site.

Attention avec la mise a jour dans votre boutique de production

Si vous avez des problémes pendant la mise-a-jour, notre support sera la pour vous.
Pendant une mise-a-jour il peut y avoir un temps d'interruption, qui peut prendre jusqu'a
plusieures heures dans certains cas.

3.2.2 Instructions pour la mise-a-jour

Avant de faire la mise-a-jour, veuillez lire les étapes a suivre dans le Changelog qui se trouve
dans l'article du module dans notre boutique. Le module actualisera si nécessaire le schéma de
la base de donnée et des fichiers du module. Si rien n'est mentionné, vous pouvez simplement
écraser les fichiers sur le serveur pour completer la mise-a-jour.
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4 Configuration du module dans la boutique
OpenCart

La configuration consiste en deux étapes.La premiére étape correspond a la configuration du
module principal avec tous les réglages de base (cf. Configuration du module principal). Au cours
de la deuxiéme étape, vous pouvez alors effectuer configurations individuelles pour chaque
méthode de paiement . Ceci permet une flexibilité totale et une adaptation parfaite a vos
processus.

Créez des back-ups!

Créez un back-up du répertoire principal de votre boutique. En cas de probléme, vous
sereztoujours en mesure de retourner votre boutique a son état original.

Nous recommandons en outre de tester l'intégration sur un systéme de test. Des
complications peuvent survenir avec des modules tiers installés par vous. En cas de
questions, notre équipe de support est a votre entiére disposition.
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5 OpencCart 3.0 Installation - Additions

Afin de garantir le bon fonctionnement et utilisation de toutes les fonctionnalités assurez-vous
que vous suivez les instructions ci-dessous.

5.1 Configuration du module principal

Vous trouverez les parameétres pour le module principal dans "Extension > Modules > 0gone Base
Module" . Installez le module en cliqguant Installer.

En cliguant Modifier vous pouvez configurer le module principal. Insérez toutes les données dans
les champs correspondants. Les données nécessaires ont déja été enregistrées dans le back-
end de 0gone a été envoyé par 0gone. Chaque option est, en outre, expliquée dans des courts
textes d'informations dans la boutique.

5.2 >Definir 'URL pour le Feedback Transaction

Pour assurer un traitement de paiement correct dans votre boutique, au moins un Feedback URL
doit étre fourni pendant la configuration de Ogone . L'URL a saisir peut étre trouvé dans votre
boutique OpenCart dans le menu Extensions > Modifications > Modules > 0gone Base Module >
Edit > More > Setup.

5.3 Configuration du module de paiement

Aprés avoir réussi a configurer le module principal, vous pouvez trouver les parameétres pour les
méthode de paiement individuelles dans votre boutique dans Extensions > Paiements . Chaque
méthode de paiement est listée individuellement. Installez les méthodes de paiement que vous
souhaitez offrir @ vos clients dans votre boutique. Vous pouvez effectuer des réglages individuels
pour chaque méthode de paiement et ainsi adapter de facon optimale les méthodes de
paiement a vos processus existants. Les options les plus centrales sont décrites plus en détail ci-
dessous..

En cliquant sur Installer la méthode de paiement est activée dans votre boutique. Cliquez
Modifier afin de modifier la configuration de la méthode de paiement.

5.4 Débit direct

L'option "Capture" vous permet de spécifier si vous voulez débiter les paiements directement ou
sivous souhaitez les authorisé et le débit du paiement a une date postérieure.

En fonction de votre contrat d'acquisition, une réservation est garantie seulement pour une
période de temps spécifique. Si vous échouez a débiter le paiement dans ce délai, l'autorisation
peut donc plus étre garantie. De plus amples informations sur ce processus se trouve ci-dessous.

Différents parametres entre le backend de Ogone et le module

Les parameétres enregistrés dans les modules de paiement peuvent remplacer les
parametres enregistrés dansogone.
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5.5 Statutincertain

Vous pouvez spécifiquement étiqueter les commandes pour lesquelles la réception de I'argent
n'est pas garantie. Cela vous permet de contréler manuellement la commande avant I'expédition.

5.5.1 Définition du statut de la commande

Pour chaque mode de paiement, vous pouvez spécifier le statut vers lequel la commande doit
étre déplacée en fonction du statut de la réservation. C'est le statut initial de la commande.

5.6 Validation

Avec l'option «Validation», vous pouvez définir le moment ol le mode de paiement doit étre
rendu visible pour le client au cours du processus de commande. Ce parameétre est pertinent
pour les modules ou l'utilisation dépend de la conformité du client avec des conditions
préalables spécifiques. Par exemple, si un contrdle de solvabilité doit etre effectué ou si le mode
de paiement est disponible uniquement dans certains pays. Pour que la vérification de la
solvabilité ou la validation de I'adresse fonctionne également avec les caractéres européens, le
jeu de caractéres du "mode Blowfish" doit étre réglé sur "UTF-8" pour certains parametres PSP.

Vous avez le choix entre deux options:

¢ Validation avant la sélection de la méthode de paiement: Une vérification de validation est
effectuée avant que le client sélectionne la méthode de paiement. S'il ou elle ne satisfait
pas les conditions, la méthode de paiement ne sont pas affichées

* Validation apreés la sélection de la méthode de paiement: La vérification de la conformité a
lieu aprés la sélection de la méthode de paiement et avant la confirmation de la
commande

* Au cours de l'autorisation: La vérification de validation est effectuée par 0gone au cours
de la procédure d'autorisation. Le mode de paiement est affiché dans tous les cas

5.6.1 Utilisation de plusieurs boutiques OpencCart

Si vous souhaitez connecter plusieurs boutiques OpenCart a un seul compte 0gone, vous avez
besoin d'un module de paiement sellxed pour chaque boutique ainsi que le module Multishop
correspondant que vous trouverez directement avec le module de paiement.

1. Veuillez extraire les fichiers du module multi-shop et ouvrir le fichier "router.php"

2. Insérez une ID dans la case "Shop ID" dans la configuration principale du module (par
exemple shop_a and shop_b)

3. Insérez la ligne suivante dans I'endroit correspondant dans le fichier router.php du
module Multishop (pour chaque boutique; shop_a et shop_b):
Sredirect['shop_a'l = 'https://www.your-shop.com/index.php?route=0gonecw/process
/notify";
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4. Insérez I'URL suivante (a la place de I'URL mentionnée ci-dessus) dans le tab "Router
d'information sur la transaction" dans le backend de Ogone: http[s]://votreboutique.com

/router.php
5. Téléchargez le fichier router.php dans le répertoire principal de votre boutique sur votre

serveur
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6 Réglages / Configuration des Méthodes de
paiement

6.1 Informations générales sur les méthodes de paiement

Tous les modules de paiement sellxed sont livrés avec des méthodes de paiement les plus
courants. In case a desired payment method is not included per default, please contact us
directly.

Afin d'étre en mesure d'utiliser un méthode de paiement, il doit étre activé dans votre compte
Ogone ainsi que dans votre boutique. Les informations sur la configuration des méthodes de
paiement peuvent étre trouvé plus haut.

Ci-dessous vous trouverez des informations importantes pour les méthodes de paiement
spécifiques qui dérogent a la procédure standard.

6.2 Informations sur le statut du paiement

Pour chague méthode de paiement, vous pouvez définir les statuts a saisir aprés compléter une
transaction (statut pour les paiements autorisés, capturés etc.). Vous pouvez définir le statut de
la commande pour chaque statut de transaction different (par exemple: un statut pour un
capturé, autorisé, etc.).

Information importante concernant le statut de la commande

Ne définissez jamais un de vos status sur Pending 0gone ou tout autre statut similaire
quivient directement du module.

6.2.1 Statut de la commande "pending" / paiement imminent (ou similaire)

Les commandes avec le statut 'Pending Ogone' sont des commandes qui n'ont pas été
terminées. Les commandes recoivent ce statut si un client est redirigé a la page de paiement,
mais n'a pas réussi a finir la son paiement ou la notification du paiement n'a pas encore atteint
votre boutique (Par exemple le client ferme la page de paiement et ne compléte pas le
paiement). Selon la méthode de paiement, ces commandes seront automatiquement
transformées en commandes annulées et l'inventaire sera corrigé (un cronjob doit étre activé).
La durée de ce changement automatique dépend des caractéristiques de la méthode de
paiement. Cela ne peut pas étre configureé.

Si vous avez beaucoup de commandes sans avoir été finalisées, cela signifie généralement que
les notifications de votre serveur Web a 0gone sont bloquées. Dans ce cas, veuillez vérifier les
parameétres de votre firewall et demandez a votre hébergeur d'accepter les IP et les User Agent
de Ogone.
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6.2.2 Statut de commande "annulé"

Les commandes avec le statut "annulé" ont recu ce statut automatiquement a cause d'un délai
d'expiration, comme décrit ci-dessus, ou ont été annulées directement par le client.

6.3 Utilisation Hidden Authorisation / Alias Gateway

Vous avez la possibilité d'accepter les paiements par carte de crédit sans redirection sur la page
de paiement de Ogone.

Afin de pouvoir utiliser cette fonction, vous devez d'abord effectuer les étapes indiquées dans
Hidden Authorisation / Alias Gateway et créer un utilisateur API.

Vous avez ainsi la possibilité d'activer la méthode d'autorisation ‘Hidden Authorisation’ pour les
modes de paiement de votre choix. Cela requiére en tant que marchand de remplir le PCI-SAQ-A-
EP (norme PCI). En aucun cas les coordonnées bancaires ne sont sauvegardées sur votre serveur.
Merci de contacter votre acquéreur pour plus d’'information sur le SAQ et les conditions requises.

6.4 Carte de crédit

Pour l'intégration, vous avez le choix d'une pré-sélection dans la boutique; c'est @ dire que le
client choisit le type de carte déja dans la boutique; ou une intégration générique dans ce cas, le
client verra que l'option «carte de crédit» comme méthode de paiement, puis choisira le type de
carte sur la page de paiement Ogone.

Order reference : sellxed_og_ 100000091 Beneficiary : customweb GmbH
Total charge : 966.00 CHF -
-

Please select a payment method by clicking on the logo.
Card: S5L secured transaction

e AL = 5
.2 859 vsa
m Can | actually pay with my Maestro card?

| uate B

About Ogone |Privacy policy |Security| Legal info

Cancel

Image 6.1: Pas de pré-sélection du type de carte - le type sera alors choisi sur la page de
paiement.

Pré-sélection de la méthode de paiement

Nous vous recommandons de choisir I'option pré-sélectionnée. Cela vous permet de
configurer les paramétres individuels pour chaque mode de paiement.
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6.5 PayPal

Vous pouvez traiter PayPal directement via 0gone. Pour faire cela, quelques ajustements dans
votre compte PayPal sont nécessaires. Veuillez suivre les étapes suivantes:

1. Activez le module de paiement dans votre boutique

2. Assurez-vous que le mode de paiement PayPal soit activé dans votre compte 0Ogone

3. Les ajustements de I'API doivent étre effectués dans votre compte PayPal. Les étapes sont
décrites dans le document "PayPal Express Checkout Integration Guide". Ce document
peut étre trouvé dans votre compte 0gone sous: Support > Manuels de l'utilisateur et d’
intégration > Guides techniques > 0gone PayPal Express Checkout Integration Guide.

6.6 Virement

Pour utiliser la méthode de paiement de transfert bancaire, assurez-vous de configurer les
parametres pour la_HTTP status changes comme décrit ci-dessus. Les paiements effectués via le
virement bancaire seront d'abord marqués comme étant 'en attente'. Dés que le client paie la
facture, Ogone enverra la notification du changement de statut et le statut de la commande sera
mis a jour.

6.7 Integration MasterPass :Ce qu'il faut garder a I'esprit

Si vous intégrez MasterPass comme une méthode de paiement dans votre boutique, vous avez
deux options d'intégration: Checkout externe et standard . Quand vous utilisez le checkout
externe ,le client ne doit pas fournir le données d'adresse pendant le checkout. Le client a
seulement besoin d'un compte MasterPass et les données seront transmises par MasterPass.
Pour utiliser cette option comme marchand, vous devez activer cette méthode de paiement avec
Ogone.

N'oubliez pas qu' en utilisant des fonctions supplémentaires telles que la transmission de
l'adresse via MasterPass, peut nécessiter I'activation des options respectives via 0gone.

Pour utiliser MasterPassen conformité avec les recommandations de MasterCard, Lisez
attentivement les informations suivantes avant d'utiliser cette méthode de paiement.
6.7.1 Possibilités d'Integration pour MasterPass

MasterPass peut étre intégré en tant que méthode de paiement normale avec redirection vers
0gone ou comme un checkout externe.

6.7.1.1 MasterPass comme méthode de paiement

Si vous désirez intégrer MasterPass comme une méthode de paiement normale, activez la
méthode de paiement comme d'habitude (seeConfiguration de la méthode de paiement). Dans
ce scénario, le client devra d'abord étre redirigé vers MasterPass puis au porte-monnaie de
'émetteur.
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6.7.1.2 MasterPass comme Checkout Externe

Si vous intégrez MasterPass comme Chekout externe, vous pouvez minimiser radicalement les
étapes pour le paiement. Le transfert d'adresse et la création du compte est traitée via
MasterPass. Si vous activez le checkout externe, il apparait un bouton dans le panier avec lequel
vOuS pouvez sauter aprés la connexion au compte directement a la derniére étape de la
confirmation de commande. La création du compte se passe au background.

Pour I'activation du checkout externe allez sur Extensions > Modifications > Modules > 0gone
Base Module > Edit > More . Vous y trouverez les parameétres pour le checkout externe:

Scope der Konfiguration: Externer Checkout

Standardkeonfiguration

ar
€

PSP Active™ Active [STORE VIEW]
Markieren Sie dieses Feld um den externen Checkout
Uber 2u aktivieren.
Externer Checkout Sort Order* 0 [STORE VIEW]
Legen Sie die Reihenfolge fest, in der externe
Checkouts angezeigt werden sollen.
Minimal Order Total* [STORE VIEW]
Define a minimal order total for this checkout to be
available.
Maximal Order Total * [STORE VIEW]

Define a maximal erder total for this checkout to be
available.

Image 6.1: activation du checkout externe.

MasterPass comme checkout externe n'est pas disponible pour toutes les situations. Si vous ne
trouvez pas ce point dans le manuel, contactez nous.

6.7.2 Checkout: MasterPass Bouton pour en savoir plus

Quand vous utilisez MasterPass comme méthode de paiement pour un checkout standard, c'est
obligatoire un lien vers le MasterPass Page pour en savoir plus. Pour le faire, allez sur
Configuration des méthodes de paiement . Collez le lien pour la Page en savoir plus dans le
champ «Description» pour les langues respectives. Le champ 'en savoir plus' va maintenant étre
affichée au moment de choisir une méthode de paiement.

Nous avons déja recueilli les liens les plus importants pour vous. Vous devez seulement copier et
coller les liens dans le champ de description:

* German:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/de/DE/" target="
_blank">Mehr Erfahren </a>

* French:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/fr/FR/" target="
_blank">apprendre plus </a>

® English: <a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/DE/" target="
_blank">Learn More </a>

® Spanish:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/ES/" target="
_blank">aprender mas </a>
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* [talian:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/it/IT/" target="
_blank">saperne di pit </a>

® Dutch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/nl/NL/" target="
_blank">Leer Meer </a>

Aktiviert Aktiviert N [STORE VIEW]

Dieze Zahlungsmethode aktivieran

Titel MasterPass [STORE VIEW]
Mame der Zahlungsmethode

Beschreibung <3 [STORE VIEW]
href="https:ffwww.mastercard.com'mec_usiwalletle
armmore/de/DE™ target="_blank"=Mehr Erfahren
</g=

Beschreibung der Zahlungsmethode

Image 6.1: Example pour insérer une description (Magento). Ces parametres se trouvent dans la
configuration du métode de paiement pour MasterPass.
[} Payment Information

O MasterPass

MasterPass (1

Mehr Erfahren

Image 6.1: La page en savoir plus devrait apparaitre dans le frontend.

Liens pour des langues supplémentaires peuvent étre trouvés dans ce document:
https://developer.mastercard.com/...

6.7.3 Informations Additionnelles

Des informations générales et sur l'utilisation de la marque et le logo MasterPass dans votre
boutique sont disponibles dans le document MasterPass Mechant Branding Requirement auquel
VOous pouvez accéder ici : https://developer.mastercard.com/...
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6.8 Utilisation de l'autorisation Ajax (FlexCheckout)

Vous avez la possibilité d'effectuer des paiements par carte de crédit sans étre redirigé vers la
page de paiement de Ogone.

Afin d'utiliser cette fonctionnalité, vous devez au-préalable executer les étapes listées ici Hidden
Autorisation, FlexCheckout (Hosted Tokenization Page), External Checkout et Alias Manager et
créer un utilisateur API.

Vous pouvez ensuite activer la méthode d'autorisation Ajax (FlexCheckout) pour les modes de
paiement de votre choix. A aucun moment les données de carte de crédit ne sont sauvegardées
survotre serveur.
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7 Le module en action

Ci-dessous vous trouverez un apercu des caractéristiques les plus importantes dans l'utilisation
quotidienne du module Ogone.

7.1 Données de transaction des commandes

Vous pouvez trouver un résumé des données de transactions les plus importantes pour toutes
les commandes passées via notre module. L'ensemble des données de transaction permettent
['attribution des commandes avec les transactions correspondantes sur votre compte Ogone.

[E] orders

Order Detalls Grder D 2

Invoice No [ Generate ]

Payment Details

Shipping Detalls Store Name Your Store

: D: X £ .
Products Store Url. hitp:lidemo.sellxed.com

Customer. Sascha krisi

History

Customer Group: Default

E-Mail: info@customweb.ch

Telephone 33123456798

Total: 78.90€

Order Status: Pending

IP Address: 1608515547

User Agent Mozilla/5.0 (X11; Linux x86_64) AppleWebKit/537 36 (KHTML, like Gecko) Ubuntu Chromium/30.0.1589.114 Chrome/30.0.1598.114 Safari/537 36
Accept Language: de,en-US;g=0.8.en,q=0.6

Date Added. 13/11/2013

Date Modified: 13M11/2013

Image 7.1: Données de transaction sur OpencCart.

7.2 Utilisation Alias Managers / Token Solution

Avec |' Alias Manager, vos clients peuvent en toute sécurité sauvegarder leurs cartes de crédit
avec 0gone pour les achats ultérieurs. L'utilisation est activé en sélectionnant I'option "Alias
Manager" dans la configuration de Payment. Le client peut alors choisir parmi ses cartes de
crédit enregistrées sans avoir a entrer de nouveau tous les détails.
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Use Stored Card | ooooooooox 0111 7

Card Holder Name*  Sascha krusi

Please enter here the card holder name on the card.

Card Number* 0000 0000 00 0111
Please enter here the number on your card.

Card Expiration® 12 Y 2015 ¥

Select the date on which your card expires.

CVC Code*

Please enter here the CVC code from your card. You find the code on the back of the card.

Confirm Order

Image 7.1: Alias Manager

Alias Manager Options

L'utilisation de I' Alias Managers nécessite l'activation de I'option correct avec Ogone.
Pour le mettre en place contactez notre support.

7.3 Modéle Dynamique

Nous fournissons un modeéle standard pour l'utilisation du modéle dynamique pour tous les
modules sellxed. Vous pouvez activer l'option en séléctionnant dans l'option "Template
Dynamique" - "Use Shop Template". Veuillez vous assurer que tous les parameétres spécifiés dans
Modéle dynamique soient effectués dans le backend de Ogone.

Le modéle dynamique vous permet d'afficher la page de paiement de 0Ogone avec le template de
votre boutique. Le client, ne remarquera pas qu'il a été redirigé sur le site de Ogone. Le template
s'ajustera dynamiquement a votre template du magasin. Ceci vous permet aussi d'intégrer un
modeéle dynamique pour les smartphones.

Le Dynamic Template a besoin d'un certificat SSL

Pour que le modéle dynamique fonctionne correctement avec tous les navigateurs, vous
avez besoin d'un certificat SSL dans votre boutique.
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Yourl'ogoHere | B W

weicome | L Login

BEST SELLEMS

N o= Pagmani

Pod shuttia
e IE 6E.05 EUR
ks odedad b g vl 35

Toad chuge - 134 35 ELR

Sws'uiy Comborsasd Lid ol Wana
i 158.07 EUR
Py ik Bhure BE210 Sound-
¥ i L B i s
Cracwddarn revees - [Taark nares Tor Pod asd IPEore

Cadnarher [ 124,58 ELR
et |—r—' i » Al Best seliers
Lol win Vwdeizy Lk Wi e i
o
Yar | poefT mE pv T
el
vt T B
Back 158.07 EUR
» Al spedils

 Discover our sbare(s]dl

Image 7.1: Le modéle s'adapte au layout de votre boutique.

' M DemoShop Barclaycard  x ﬂ

<« C'  { nttps://mdepaymentsyy =
Yahoo! Sports Fanta... @ Backend

Pay with :

Cardholder' y
it sname- Test Payment

Card number*

Expiry date (mm (V]
i
yyyyy
: (V]
Card verification
code*
I What is this?
* Mandatory fields

Yes, | confirm my payment

Image 7.1: Modéle dynamique avec le skin mobile.

7.4 Débit / annulation de commandes

7.41 Capturer les commandes

Afin de capturer les commandes, ouvrir les informations de transaction dans Sales > Ogone .
Vous trouverez ici un apercu de toutes les transactions.Vous y trouverez des informations sur la
transaction. En cliquant sur "vue" vous ouvrirez la transaction de l'ordre.
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7.4.1.1 Capture commandes complétes ou la capture partielle

En cliquant sur le bouton "Capture Transaction" une nouvelle fenétre s'ouvre. Vous pouvez
maintenant capturer chaque élément individuellement au cas ou vous ne souhaitez pas envoyer
tous les éléments a la fois. La quantité de possibles captures partielles dépend de votre contrat.
Contactez Ogone directement pour clarifier vos questions.

Capture des commandes dans le back-end de Ogone

La gestion des transactions entre votre boutique et 0gone n'est pas synchronisée. Si
vous capturez des paiements avec 0gone, le statut dans la boutique ne sera pas mis a
jour et une seconde capture dans la boutique n' est pas possible.

Au cas ol vous ne souhaitez pas capturer tous les éléments d'une commande, vous pouvez
fermer la transaction en cliquant sur la boite.

PARTIAL CAPTURE

With the following form you can perform a partial capture.

Name SKU Type Tax Rate Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
iPhone product11  product 0% | 1 | 74.24 | 74.24
Flat Shipping Rate  shipping shipping 0% | 1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Image 7.1: Capture des commandes

Capture Partiel

Vérifiez si la capture de quantités partielles est pris en charge avec votre contrat avec
ogone . Si cela est le cas, que la transaction soit fermée pour de nouvelles opérations
aprés une capture partielle.

7.4.2 Annuler les commandes

En cliquant "Annuler la Transaction", la transaction est annulé et le montant de la réserve sur la
carte de votre client est automatiquement rendu.
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Capture Transaction Refund Transaction

Image 7.1: Capturer ou Annuler in OpencCart.
7.5 Remboursement des commandes
Afin de rembourser les commandes, ouvrir les informations de transaction (cf. above).

Vous pouvez rembourser des éléments individuels ou tout montant de votre choix en modifiant
la quantité totale ou la quantité d'articles.
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PARTIAL REFUND

With the following form you can perform a partial refund.

MName SKU Type Tax Rate Quantity Total Amount (exel. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 7424

Flat Shipping Rate shipping shipping 0% I 1 I 3.68 I 368
Total Refund Amount: 7791 EUR

Close transaction for further refunds

Image 7.1: Remboursement OpenCart pour Ogone.

Remboursement maximal

Avec notre module il est impossible de rembourser plus de 100% du montant autorisé
initialement.

7.6 Mise en place d'un cron job pour activer les opérations
chronomeétrées

Pour activer les opérations chronométrées du plugin (e.g. update service, deleting pending
orders, etc.) assurez vous que vous avez activé le Cron Engine de OpenCart . En particulier, la
fonction de mise a jour vous permet de récupérer automatiquement des informations
supplémentaires ou change votre commande directement via I'API deOgone. Pour utiliser la
fonction mise a jour, peut etre que 0gone doit activer des options supplémentaires dans votre
compte.

Pour utiliser les opérations chronomeétrées, planifiez un cron job dans votre server pour le
controller suivant:

https://www.your-shop.com/index.php?route=o0gonecw/cron/cron

0On vous conseille d'utiliser un Cron Engine come par example EasyCron. De cette fagon, vous
pouvez Cela vous permet d'ouvrir le fichier (URL) avec un service externe.
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8 Testing
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Avant de passer au mode productif, vous devez tester le module.

Apreés vos tests

N'oubliez pas de changer au mode productif aprés avoir fini vos tests.

8.1 Données de test

Voici les donnés de test:
Credit / Debit Card

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

American Express

Kartennummer
Expiry Date
cvc

MasterCard
Kartennummer
Expiry Date
cvc

Visa
Kartennummer
Expiry Date
Ccvc

Kartennummer
Expiry Date
cvc

3750 0000 000 0007
12/2020
1234

5399 9999 9999 9999
12/2020
123

41111111 11111111
12/2020
123

4000 0000 0000 0002
12/2020
123

3750 0000 000 0007
12/2020
1234

53999999 9999 9999
12/2020
123

4000 0000 0000 0002
12/2020
123

41111111 11111111
12/2020
123

American Express

Mastercard

VISA (Without 3-D Secure Check)

VISA (With 3-D Secure Check)

American Express

Mastercard

VISA (With 3-D Secure Check)

VISA (Without 3-D Secure Check)
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9 Erreurs et solutions

Vous trouverez notre FAQ avec les erreurs et leurs solutions sous http://www.Ssellxed.com/en/faq
. Si le probléme n'est pas résolu, vous pouvez contacter notre support sous: http://www.sellxed.
com/en/support

9.1 L'URL'Referrer' apparait dans Analytics

Dans certains cas, les URL's 'Referrer' sont falisifée par 0gone dans Analytics. Cela se passe
quand le client envoie une 'Header Redirection'. Cela peut étre résolu dans la configuration de
votre systéme Analytics.

Pour Google Analytics, un example pour PayPal ce trouve ici.
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